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1 Generally

The universal encoder system U-ONE®-Compact UOC 40 and the electronic position switch
ERC 40 is referred to as UOC 40 / ERC 40 in the following documentation.

This document explains how to set the parameters of the U-ONE®-Compact using the software
US42Pro and then transfer the settings to the device.

1.1 Abbreviations and terminology used

UOC 40 U-ONE®-Compact universal encoder system

ERC 40 Electronic position switch

ECUC Module control unit

ERC C-R Module position switch with positively driven contacts
EGS C-R Module overspeed switch with positively driven contacts

1.2 System requirements

For configuration purposes it is possible to use any commercially available Windows® note-
books/PCs that fulfil the following system requirements:

Windows® XP SP3/ Vista/7/8/8.1/10.

Free space on the HDD: 150 MB (+ Dot Net Framework).
Available USB 2.0 port.

1 GB RAM, CPU: 1GHz, screen resolution 1024 x 768.

2 Installing the software
Ensure the device and your notebook/PC are connected via the USB cable.
Close the a3utomatically started ,Found new hardware wizard“ with a click on “Cancel”.

Place the supplied CD containing the software into the CD drive or, alternatively, download the
Setup.exe. If the Setup.exe does not run automatically, navigate via Explorer on the CD-ROM
drive and there start the Setup.exe.

1. The Setup guides you through the installation. Please follow the instructions on the
monitor.
If you use Windows XP, Vista or 7, continue with step 2, users higher operating system
versions go on to step 3.

2. Windows XP SP3/ Vista/7

Due to the ended support for your operating system, it is no longer possible for us to
sign the driver; therefore you need to confirm the installation manually. To do this, in
Windows XP, click on “ Continue Anyway ”. In Windows Vista and 7 click on “ Install
this driver software anyway ”. After that, the setup routine will continue.

Har dware Installation 53 Windows Security =2

[) The software you are installing for this hardware: @ Windows can't verify the publisher of this driver software
.

JHE USB Device
= Don'tinstall this driver software

You should check your manufacturer's website for updated driver software
for your device

= Install this driver software anyway
Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or st
information.

€3

Fig. 2-1: Software Installation 1

3. Completion
The software has been installed and starts automatically.

UOC40_ERC40_ECU-Konfigmanual-en_R3
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2.1 Installing the driver manually

O PLEASE NOTE!

l You must log into a user account with administrator rights to install the software.
Ensure all programs are closed.

If it is necessary to install the driver manually, depending on your operating system, please
check the following steps.

Connect the supplied USB cable with the UOC 40 / ERC 40 and your notebook/PC

By pressing “Windows key” “Pause/Break” or desktop “Computer” (right click) “Properties” you
get into the System Properties.

Open the device manager, which lists all the connected devices. Select “JHG Dev” (right click)

“Update Driver”
==
) Upate DrierScttware - WG De
)\ ) [® Control Panel » Al Control PanelTtems » System + ][ 5=
Control Panel Home . . ) o

View basic information about your computer : ¥ Network adapters

Windows edition a -5 Other devices
Windaws 7 Professional i il HGE
Copyright © 2008 Microsoft Corporation. All rights reserved. [N 4. I Ports ( Update Driver Software...
Service Pack 1 : 0

s | isanle

Get more features with a new edition of Windows 7 : 1 Processq

b8 System ¢ Uninstall

Fig. 2-2: Driver software Installation 2

Now select the installation source via “Browse” and point to path of your installation, there
select the folder drivers. The Installation begins with a click on Next.

) (==
& L Upcote Drver Software - JHG Dev
Browse for driver software on your computer Click Next, the installation of the driver
Sench o dvr e in i oo software for the UOC 40 / ERC 40 has been
") completed.
Finish the installation with “close”.
The UOC 40/ ERC 40 is now ready to be
< Let me pick from a list of device drivers on my computer
I:;;‘,‘::!f‘;"::;::‘:;L:S;“:;::S::Ji;?m“‘“W'“"‘y“““f&”" used.

Fig. 2-3: Driver software Installation 3

UOC40_ERC40_ECU-Konfigmanual-en_R3
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2.2 Manual driver installation under Windows XP SP3

3

System Properties evice Manager

System Restars Automatic Updates Femots

Hardware

3

General Computer Name Adwanced

Action  Wiew  Help

W EHE 2B

Diewvice Managsr
- The Device Manager lists all the hardware devices installed
s on your computer. Use the Device Manager to change the

propetties of any device.

‘ WINKPEMTEST

a Batteries

§ Computer
% Disk drives

Device Manager
Diivers

@ + Diiver Sigring lets you make sure that installed drivers are
2 compatible with Windows. Windows Update lets you set up
Fiow Windawss connects to Windaws Update far diivers.

» Keyboards

[ e [ [ o

# Monitors

* é Systel
Hardware Profiles + Univer

@ Display adapters

,_; DYD/CD-ROM drives

{85 Human Interface Devices
(=) IDE ATAJATAPI contrallers

Mice and other pointing devices

[ Driver Signing J [ windows Update | +1- B8 Newwork adspters
- =%k Other devices
Hardware Profiles il e
Hardware profiles provide a wa for you to set up and store - o Forts
different hardware configurations 5@, sound | DEabEE

Uninstall

Scan For hardware changes

Properties

Launches the Hardware Update Wizard for the selected device,

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard
Windows will search for curent and updated software by

looking an your computer, on the hardware installation CO, ar an
the Windows pdate "wWeb site [with wour permiszion],

Read our privacy policy

Can‘windows connect to Windows Update to search for
software?

(e, this time only
(O es, now and every time | connect a device
&) No, not this time

Click Mext to continue

Found New Hardware Wizard

Thiz wizard helps pou install software for:

JHG Dev

) If your hardware came with an installation CD

g2 or Hloppy disk. insert it now.

‘What do you want the wizard to do”?

O Install the snitwiae 2 ally [Recommended)
%) Install from & list or specific location (Advanced

Click. Mext to continue,

[ < Back “ Mest » ][ Cancel ]

Fig. 2-4: Software Installation XP SP3

Now select the installation source via “Browse” and point to path of your installation, there
select the folder drivers. The Installation begins with a click on Next.

Click Next, the installation of the driver software for
the UOC 40/ ERC 40 has been completed.
Finish the installation with “close”.

The UOC 40/ ERC 40 is now ready to be used.

Found New Hardware Wizard

Please choose your search and installation options.

@ Search for the best driver in these locations.

Use the check boxes below ta limit or expand the default search, which includes local
paths and removable media. The best diver found will be installed

[] Search removable media (floppy. CD-AOM...|

Include this location in the search

© Don't search. | will choose the driver to install,

Chaose this aplion ta select the devie driver fom a list, Windows daes nat guarantee that
the driver you choose will be the best match for paur hardware

[ <Bak J[ Mews | [ Cancel |

Fig. 2-5: Driver Software Installation XP SP3

UOC40_ERC40_ECU-Konfigmanual-en_R3
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3 Setting up UOC 40 / ERC 40

Allow sufficient time to plan the integration and configuration of the UOC 40 / ERC 40. Please
remember that planning and configuration errors can put people at risk. Put organizational
measures in place to guarantee the safe system state during configuration procedures!

Ensure that the system cannot enter any dangerous states during the configuration proce-
dures including in that part of the system monitored by devices connected to the UOC 40/
ERC 40.

To configure the UOC 40 / ERC 40 you require the following:

e Operating-and configuring instructions belonging to the UOC 40/ ERC 40
Notebook/PC running a Windows® operating system

e The configuration software US42Pro (administrator rights are required to install the soft-
ware)

¢ USB-Connecting cable to connect the notebook/PC with the UOC 40 / ERC 40

3.1 Planning

Caution!
A Ensure you have planned the application thoroughly before you begin to configure the
UOC 40/ ERC 40!

Amongst other considerations the planning must include:

e A detailed safety analysis of the planned application

o A complete list of all required devices, their connections as well as the signals and switch-
ing points provided or required by UOC 40 / ERC 40.

In addition, the following conditions must be fulfilled:
e The UOC 40/ ERC 40 must be connected to the power supply.

Read also the appropriate operating and assembly instructions.

UOC40_ERC40_ECU-Konfigmanual-en_R3
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4 Software description US42Pro

In this chapter you will learn how to configure the UOC 40/ ERC 40 in its respective device
combination using the configuration software US42Pro. For the purpose of clarity the user in-
terface is divided up into different sections.

The drawing below offers a schematic overview:

Head section e Head section:

This is where the elements used to control
the software are displayed (see Chapter
4.1.1).

Display section | Configuration section | ®Display section: o .
The display section is always visible and is

used to show the available modules and
their status. (See chapter 6.2.1).
In the upper section the current speed, the
current position and the optional analog out-
put current is displayed.

e Configuration section:
This is where the module parameters are
entered on the tab pages (see Chapter 5).

Fig. 4-1: schematic overview of the user inter-
face

4.1 Fundamental procedure
The UOC 40/ ERC 40 is configured by taking the following steps:
1. Turn on the Notebook/PC
Connect the UOC 40/ ERC 40 to the USB port of the Notebook/PC
Switch on the UOC 40/ ERC 40
Launch the software US42Pro and set up connection (see chapter 5.1)
Log onto the UOC 40 / ERC 40 (please refer to Chapter 4.1.6)
Configure UOC 40/ ERC 40 (please refer to Chapter 5).
Check parameter settings
Approve the parameters in the UOC 40/ ERC 40
Test the parameter settings of the UOC 40 / ERC 40 on a secured system

© o N TN

The UOC 40/ ERC 40 is ready for operations after completing these steps.

_ UOC40_ERC40_ECU-Konfigmanual-en_R3
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4.1.1 User interface head section

The menu bar containing basic commands to operate the software is located in the head
section.

4.1.2 Pulldown menu: File & Import Parameters

e To check the content of saved parameter sets when the device is ' y
: “ » Settings  Analyse ?
not connected click “Import Parameters”. ,
Import parameters

-
e When the device is connected it is possible to load parameters 1H Expion perarneter:
into the input masks that were saved using the “Export |8

Report
Parameters” function.

' » Offline
e When the device is connected and the user signed in, it is “l Close
possible to save imported parameters to the device. Fig. 4-2: File

4.1.3 Pulldown menu: File > Export Parameters

To save device parameters to a Notebook/PC click “Export Parameters”.

4.1.4 Pulldown menu: File - Report
Click “Report” to save device parameters to a CSV file.

Using the Form Letter function in Word (for example, Word 2013), it is possible to save
device parameters for documentation purposes in Word templates as follows:
1. Open the associated template file for the device

(for example, UOC 40_ReportDDA_RXx.dotx). Then select the (successive) buttons framed
in red.

Opening this document will run the following SQL command: Select text separator

. . Indicate which separator character is used to divide the
SELECT * FROM 'txtEB020.csv data fields of your address list:

B

Data from your database will be placed in the document. Do you want to continue? e
(_) Comma

(O Other. |;

i | First row of data contains column headers
Ei i
Cancel

| ShowHelp >> |

Open data source:

|'@ sample.docx is a mail merge main document, Word cannot find its data OLE DB Database Files A
\ source, .

i Options...

3. Click OK 2x to confirm

Rt tle Connetbon Paanetere The parameters have been saved to the
e i template. You can make any changes
Indicate which separator character is used to divide the you Ilke to the template USlng the Word
data fields of your address list: . « . y op .

function “Insert Merge Field” it is possi-
ble to add more parameters.

O Other: |;

First row of data contains column headers

UOC40_ERC40_ECU-Konfigmanual-en_R3 _
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4.1.5 Pulldown menu: File = Offline

In offline mode, a device parameter set can be created without UOC 40 / ERC 40 as
follows:

e Avirtual UOC 40/ ERC 40 is created by

entering the type designation. e (R

e The parameterization of the virtual UOC
40 / ERC 40 can be carried out.

o With ,Export parameters” the parameters
are stored and can be loaded by a UOC

40 / ERC 40 with the same type
designation. ‘

The offline-state will be exited via

Connection

bisconned ‘ .

&
Fig. 4-3: Offline

4.1.6 Pulldown menu: Option Lan
6 Pulldo enu: Options 2 Language ————
Depending on the regional setting of your Windows operating e t:;gn“g* ’
system the software language is determined. The language I&  change password
'English’ is selected if no corresponding data record is available. It | e
is possible to select a different language via the menu item (g Ficac
'Language'. 1B Determine calibration factor

Fig. 4-4: Settings

4.1.7 Pulldown menu: Options =>Login

To access and work on the assigned user level, the user must log into UOC 40 / ERC 40
via the menu item 'Login password' with his or her password.

4.1.8 Pulldown menu: Options ->Change password

Admin and Tester passwords are assigned via the menu item 'Change password'. A
closed padlock in the header indicates that a user-specific password has been assigned.

Authorization levels:

Three authorization levels are available to the user; however, it is only possible to activate
two of these levels by means of password authentication. The password must be between
6-12 ASCII characters (0x20 - Ox7E) in length.

Level 0:  Observer (no password required)
The following functions are available on this level:
- Establish communications with UOC 40 / ERC 40
- Enter password
- Display assigned parameters
- Display saved parameter sets

UOC40_ERC40_ECU-Konfigmanual-en_R3
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Level 1:  Tester (password level 1)
On this level the following functions are available in
addition to those on level O:
- Perform test of switch
- Generate test logs

Level 2:  Admin (password level 2)
On this level the following functions are available in
addition to those on level 1:
- Change parameters
- Save parameter sets

Default passwords on delivery are 'huebnerl' for Timeoutin: 10 min Login: Admin 4

password level 1 and 'huebner2' for password level 2.
A padlock with an open shackle symbolizes that the
password “huebner2” has not yet been changed,;
consequently, the configuration is not secured against unauthorized changes.

Fig. 4-5: Partial view header

A closed padlock shackle indicates the configuration is securely protected against
unauthorized changes. How to save the configuration is described in chapter 5.4.
The authorization level is displayed in plain text to the left of the padlock symbol
(here the level is: Admin), with which the user is logged into the UOC 40/ ERC 40 .

O PLEASE NOTE!
l The login password is set ex-works to ‘huebnerl’ or ‘huebner2'.

ATTENTION!
Change the Admin password as soon as possible to protect the configuration from

unauthorized access! (Chapter 4.1.8)

4.1.9 Pulldown menu: Options 2 firmware update

The UOC 40/ ERC 40 is prepared for a firmware update by electrically connecting

terminal 1 (+ U) and terminal 2 (Errorl) during power up. After switching on, this
connection must be removed again.

& Bootloader

The button| (3 |.selects the update file. Datei 7

Devicelnfo: - =E

»1ransfer” starts the update process.

After the update process, the device must be
restarted. Atusl Datsi: 00

O NOTEI Gesamtfortschitt:

1 Before the restard, the connection
must be removed.

Fig. 4-6: firmware update

UOC40_ERC40_ECU-Konfigmanual-en_R3
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4.1.10 Pulldown menu: Options 2 Reset to factory settings
All parameters and the UOC 40 / ERC 40 will be deleted and reset to factory settings.

Factory settings:

Password levell huebnerl Programmed Deleted
Password level2 huebner2 switching points
Operating mode Position- Current output Deactivated
(UOC 40 only) speed mode Current output Position
_Reset and preset Deactivated source dependent
input
Incremental output
. 4096
(optional)
4.1.11 Pulldown menu: Options >Recover password
If a user forgets his/her password, it is possible to —— =
assign a new password using the “Recover Pass- o [BE T e |
word” function and following the steps below: Fscovesy 087 ot to Huetoork
o Select “Recover Password”.
e To generate a recovery key click the e N
[ ememeroenker | putton, then click the[ L |
button to send the request to the manufac- | tewsesswos )
turer immediately or later if there is no In- i posmart @
ternet connection. ‘
. | Set password
e Arecovery password will be generated

and sent back to the designated recipient.
e ltis possible to assign a new password
once the recovery password has been entered in the appropriate field.

Fig. 4-6: recover password

UOC40_ERC40_ECU-Konfigmanual-en_R3
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4.1.12 Pulldown menu: Options =2 Determine calibration factor
see chapter 5.3.2

4.1.13 Pulldown menu: “Analysis” - switch test

It is possible to alter the switch status Sl - ]
by means of a switch test incorporated Switch lest has proriy over
in the configuration software US42Pro. el

The switch test is only available when
the encoder shaft is at a standstill.

It is possible to oversee the changes to X2 SRC St|i 55 |t 56 [
e e Mo AT o e e o

Switchtest

X SRC S| % ] 5 [

To confirm and activate the switch test

click

Fig. 4-7: Switchtest

CAUTION!
An error will be triggered if the encoder shaft turns during the switch test.

CAUTION!
The switch test has priority over programmed switching functions.

A
A

UOC40_ERC40_ECU-Konfigmanual-en_R3
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4.1.14 Pulldown menu ,,?*

e Info '
Displays the software version and Johannes Hubner contact details. |& Infe
e Help @ Hep

Opens the current configuration data in PDF format. [§ Documentation

e Documentation
Opens the folder containing the UOC 40 / ERC 40 documentation. This is where the
connection diagrams, dimension drawings and operating and assembly instructions
and the configuration manual are stored.

Info B
4.1.15 Generate supportfile | s USt2Pro Veran 234 .
In the pull-down menu "?" Under "Info" with the HUBNER “""
button l Generate support file ‘ a Support file is ideas and salutions
generated, which serves for the error analysis.
NOTE! é!mklg::hh Maschinen GbH
O Please send the support file with a ==
1 short description of the conditions un- e AR
der which the error occurred, by email
to the manufacturer. S
If the e-mail checkbox is activated, the file is
transferred directly to the installed e-mail et B

rogram.
brog Fig. 4-8: Info

4.1.16 Display calibration settings

The calibration settings are displayed here and also changed with ,Start parameteriza-
tion®.

. View calibration settings L, Show devicedata

4.1.17 Display device data
All device data, grouped according to the terminal boxes, are displayed here.

Devicedata | Eror Log

Terminalbox
X1 x2 X3
Calibration settings | Options
123456 Operation mode: Position- Speedmede
PN164-61%:2.04.00 Lower systemborder. 1
USC421D-A Upper systemborder: 1235
8192 Calibration factor: 12

32768 Unt: m

Last change: 770954

curent elecrorics temperature [T] 38,2

Operating hours ] 815733

Fig. 4-9: Device data

UOC40_ERC40_ECU-Konfigmanual-en_R3
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4.1.18 Fault memory

Devicedata | Emor Log #: Memory
Time: Time of error occurrence

H Time Emor number Log-Text
1 20:26:39.0967 | 30 Extem: Undervoltage detected

(Operating hours)

The error memory is a ring memory and can accommodate 100 error entries. Internal er-
rors should be sent to the manufacturer for analysis. An error analysis record is generated
as follows:

The button | k= |in the display area of the fault memory generates an error log file,
which can then be saved.

4.2 User interface - display section
The display section (left column):

¢ Displays the device type

¢ Displays present position, speed and current values.

e Lists all modules of the UOC 40 / ERC 40.
The assignment to the individual terminal boxes is displayed as X1, X2, X3 in the same
sequence that mirrors how the modules are arranged (see Fig. 5-3).
X1 is always the terminal box of the ECU C.
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5 Configuring UOC 40/ ERC 40
You must first calibrate the position system before configuring UOC 40/ ERC 40
(chapter 5.3). Device calibration and device configuration operations are only possible on
the password level “Admin”.

CAUTION!

It is only possible to assign parameters and calibrate the device when the
' device is at a standstill!

b The UOC 40/ ERC 40 enters a safe state if rotary motion is detected when
parameters are being assigned

5.1 Launching the software US42Pro

When the software is launched, the start |22
screen is displayed.

Click 'Connect' to establish communica-
tions with the UOC 40 / ERC 40 device.
The connection status is indicated on the
right of the button.

Display Status
grey not con-
nected
change .
light green / dark connected ==10
green Fig. 5-1: Start screen
After the connection setup, the device data are Password 8
read out. To calibrate and configure the UOC 40 /
ERC 40 the user must first log in using the Admin e [ tean |
password.

Fig. 5-2: Login

ATTENTION!
Change the Admin password 'huebner2' to protect the configuration from unauthorized ac-
cess. (Chapter 4.1.6)

5.2 Operating mode (UOC 40 only)
The ERC 40 is always operated in the position mode.

5.2.1 Speed mode
Select the operating mode “Speed mode” if no position dependent switching points or
position dependent current values 4 mA...20 mA are used.
It is not necessary to calibrate the UOC 40 / ERC 40 in this operating mode.

5.2.2 Position and speed mode
Select the operating mode “Position and speed mode” if position dependent switching
points or position dependent current values 4 mA...20 mA are used.
In this operating mode it is necessary to calibrate the UOC 40 / ERC 40 (see Chap.5.3).
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5.3 Calibrating the position system

To calibrate the position system (adapt the internal device processing to mirror actual

conditions at the place of installation) it is necessary to determine the system limits, cali-

bration point, calibration factor and unit.

e The system limits define the max. possible working range. An error will be
triggered if values exceed or fall below the defined range.

O PLEASE NOTE!

l To avoid system limit errors ensure sufficient clearance between the sys-
tem limits and the switching points.

e The operating range must not exceed 32768 rotations of the device shaft.
e The preset position value is a defined position point (calibration point).

e The calibration factor is the adaption factor between system units and device units.
It is assumed that this ratio is constant.

If unknown, it is possible to determine the calibration factor via the menu item “Options
- Determine calibration factor” (see Chap.5.3.2).

In this instance it is possible to determine the calibration factor with the aid of 2
calibration points, the interval between which should be as great as possible but must
not exceed the system limits.

calibration settings
Operation mode:
&y Position- —~
® Speedmode (L) Speedmode
Calibrate position system

Preset

12

Lower systemborder: Calibration factor: Upper systemborder;

1 12 1235

Wi " 5 -
Write to Device o Undo changes % Finish programming

Fig. 5-3: Calibrating the system
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5.3.1 Calibration
1. Select the desired unit via the pulldown menu.

2. Enter the values for the system limits and the calibration point (preset).
The following constraint applies:

Lower system limit < calibration point < upper system limit

3. Enter calibration factor. For information on calculating the calibration factor see chap.
5.3.3.

4. To save values to the UOC 40/ ERC 40 click [& weeo~e  see chap. 5.4.

5. Move to the calibration point (preset), shut down the drive and click the @ button.
The current position is saved as the calibration point.

6. To complete the calibration procedure click »[ Faeie= 4 button. The UOC 40/ ERC
40 is calibrated and can now be configured.

5.3.2 Determining the calibration factor with two calibration points

1. Enter calibration point 1 and calibration point 2. ;
The following constraints apply: | e
e Lower system limit < calibration point 1 :
e Calibration point 1 < calibration point 2 e —
e Calibration point 2 < upper system limit

2. Move to calibration point 1 and shut down the drive,
click the button @ The current position is saved as calibration point 1.

3. Move to calibration point 2 and shut down the drive, click the button . The
current position is saved as calibration point 2.

4. The calibration factor has been calculated, saved to the clipboard and can now be in-
serted in the appropriate dialog box.

Fig. 5-4: Determining the calibration factor

5.3.3 Determining the calibration factor by calculation
Calibration factor = (device shaft rotations) x 8192 / Actual path in number of plant units

Example:
34.5 m travel corresponds to 125.7 rotations of the device shaft.

Calibration factor = 125.7 x 8192 / 34.5 = 29847.37
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5.4 Saving configuration- or parameterisation data in the UOC 40 / ERC 40
All entries are formally checked prior to data transmission.

Incorrect entries are highlighted red and data transmission to the UOC 40 / ERC 40 are

prevented.

If the entries comply with the conditions
above (chapter 5.3.2), the values are
transmitted to the UOC 40 / ERC 40,
checked, activated and saved temporari-
ly.

The compare dialog box displays the
values entered in the input mask and the
values read out of the UOC 40/ ERC 40
(Fig. 5-5). The user confirms the values
are correct by clicking the green tick.

The values are only now permanently
stored.

Values to write: Values from device

Please compare the values o wiite
A to the values from the device and confirm AR S

Fig. 5-5: Comparison dialog box

UOC40_ERC40_ECU-Konfigmanual-en_R3



UOC 40/ ERC 40 somannes

Configuration manual ECU C/ERCC/EGS C FILUBNER

6 Functions

6.1 ECU C module
The ECU C module (Control Unit) is the central control unit of the UOC 40 / ERC 40.

To assign the module a user-defined designation click the symbol # . That makes it easy
to allocate the device on site (for example, “drive 2"). The length of the designation is lim-
ited to 12 characters.

On the tabbed page “Options” it is possible to make the following settings.

6.1.1 Digital inputs
The inputs must be activated prior to use. Both inputs are 2-channel types and active low;
in other words, when quiescent the inputs must be high. A falling edge at both channels

initiates the process. Valid rising edges initiate the process. The duration of the low level

signal T1 can be configured - and is the same for both inputs.

e Reset input: Preset input enabled Reset input enabled

A reset procedure re-initializes the whole UOC 40 ® R — =
reset value:|12(| m Preset

/ ERC 40 system and resets errors. e

e Preset input: - T1—» Preset /Reset
A preset procedure sets the current position to the

L. . . . 15— Status

preset position configured in the device. A low it (only on Praget)

level signal at the status output (approx. 1s)

acknowledges a valid preset procedure.

T1: |200... 2000 V| ms

The time T1 can be set between 20 ms ... 200 ms
or 200 ms ... 2000 ms [] Preset/Reset aktive on 1
(factory setting: 200 ms ... 2000 ms).

0 Reset intemal emor via reset
or via power on/off

Fig. 6-1Preset inputs

The behaviour of the Reset and Preset inputs can |-—ﬂ—-| Preset /Reset

be changed from Low active to High active with —_—
“Preset/Reset 1 active”.

Status
{only on Preset)

Fig. 6-2Digital inputs

A

CAUTION!
It is only allowed to set a preset “on the fly” if a risk analysis determines the
application is suitable to allow this function.

A

CAUTION!

A preset does not influence the position value of the bus module. It is only
possible to alter this position value via the bus interface.
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6.1.2 Digital outputs

There are 2 digital outputs: Status- and error output.

e Error output:
When the status is error-free, the error output has a high level.

An error is indicated by a low-level signal at the error output, which can be reset via the
configuration software "US42Pro". It is possible to set the error performance via
interrupting the supply voltage (> 2s) or by initiating a reset at the reset input.

The reset always initiates a system reboot including a complete system test. If an error
is determined again, the device remains in an error condition. Error logs are saved in
the error memory.

CAUTION!
A The "fault reset via the reset input or power supply interruption" option
- may be used only if a risk analysis has shown that the application is
suitable.

e Status output:
The status output indicates the operating status in conjunction with the error output of
the UOC 40/ ERC 40 (see separate operating and assembly instructions, chapter:
operating statuses and indicators).
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6.1.3 Current output

The current output can be set to speed (UOC 40 only) or position dependent on the menu
and must be activated before use.

6.1.3.1 Configuring the position-dependent current output 7] curent ot enabled
To configure the position-dependent current output it is nec- Systenbordsr @ .M m
essary to enter 2 position values, which must be within the oo (pston eponien. .2

Pos1 (4 mA): 110 m

system limits.
The smaller position value is assigned current Inin = 4 mA and
the larger position value Imax = 20 mA.

Pos2 (20 mA): 180 m

Output upon Limit Exceedance
OmA

@ 4mAlower, 20mA upper mit

The following restriction applies

e Posl < Pos2

If the current position is outside of the defined position range, z
the current output is switched to high impedance (I = 0 mA).
(Factory setting). . ; 5
Alternatively, it is possible to select a setting to take effect in 0o s e e e
the event the value falls below or exceeds the determined po-

sition range 4 mA or 20 mA.

20

4

Fig. 6-3: Configuring position depend-
ent-current output

6.1.3.2 Configuring the speed-dependent current output
(UOC 40 Only) Current output enabled

Curment output {not fail-safe)

To configure the speed-dependent current output it is neces- Seino/ence BE - 2N (e
sary to enter the speed n2o ma. When at a standstill a current i
of 4 mA flows.
The following constraint applies: -

e Naoma < (approved mechanical speed -10%) o
If the speed exceeds the speed range (Ncurrent > N20ma), the O 20ma
current output is switched to high resistance
(I =0 mA) — (factory setting) and an error is triggered. 2
Alternatively, it is possible to select a setting to take effect in ,
the event the value exceeds the determined position range L
20 mA. 4

0

speeddependent v

Mot 500 | Pm

100 200 300 400 500

Fig. 6-4: Configuring speed dependent-
current output

6.1.4 Configuring the incremental output (UOC 40 only)

The incremental output is optional. To configure the incre- Inremerta el
mental output it is possible to select a pulse rate of 1024 or M e LILIL
4096 e —

(factory setting: 4096).

Fig. 6-5 Configuring incremental output
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6.2 ERC C module

The ERC C module is a position switch module and contains 3 or 6 position switches. The
position switch opens or closes depending on the position value. It is possible to imple-
ment a cam with a single switch; in other words, a switch-on and switch-off position and

the associated hysteresis switching points.

The position values to be entered must be within system limits. It is possible to assign
each position switch an application-specific designation (max. 12 characters). Switching
modules with 6 position switches are configured on 2 monitor display screens. The pa-
rameters are entered in the table as shown opposite.

The values are highlighted yellow if there is a possibil- F— =
ity that the minimum time interval (2 ms) between 2 o o |
switching conditions could be undershot. If such an e o ‘
event occurs the user must check the time interval in

his application.

e P1: Hysteresis switching point of P2.
e P3: Hysteresis switching point of P4.

The following condition applies:
P1<P2<P3<P4

¢ Inverted: The switch operates inverted
(see switch S3).

e Error switch: Switch opens only in the
event an error occurs (see switch S2).

e Openif an error occurs:
Switch operates as configured, but
opens if an error occurs.

The switching points are depicted in their
correct position in the graphic opposite.

The green marker indicates the current
position.

Click "Write to device" to finish configuring
the module

] m) m] ]

m 113 115 12 ]

Fig. 6-6: Warning notice

[Erc | Device type: UOC40

Systemborder:  -10 234 m

P1 P2 P3 P4

"

Programming mode

Switch Name
S1 Pos. Switch

52
S3

P1 P2 P3 P4
m] im] m] m]
s1 78 80 83 85 B

b S3 2 0 90 92

i Prefill cument row

Acquire curent posttion
value

Disable cument
switch

-10 10 30 50 70 S0 130 150 170

[\% Wite to Devlce] ig
Fig.: 6-7 Configuration ERC C module

110

Undo changes l
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6.2.1 Depiction in the display section

The module is depicted as follows in the display section:
The switching states of the individual switches are represented by switch symbols .

Description
1| Module position
51 == Position
X2 ERC 52 - Postion2 I 2 | Module type
53 == Position3
54 -
X2 ERC S5 ~- \ .
56 ~- 3 | Switch statuses

LA A

5

4 | User designation

5| Module status

Fig.: 6-8 Display Area

6.3 EGS C module (USC 40 only)

Meaning
X2: 2. Terminal box
ERC: Position switch module

Switch symbol

Black: Error-free

Gray: Not configured

Red: Error

Switch designation assigned
by user

Gray: Not configured
Green: Error-free
Red: Error

The EGS C-module is a speed switch module. The speed switch opens or closes depend-
ing on the speed. A speed switch module has 3 or 6 speed switches. Switching modules
with 6 speed switches are configured on 2 configuration screens. Fundamentally, all
switching speed inputs must be within the device-specific switching range

0.5-2520 rpm.

The speed-dependent functions are de-
picted in a graphic in the top part of the
screen.

The input fields for entering speed
switching points are displayed in the
lower part of the screen in table form.
One line is allocated to each respective
switch (S1-S3 or S1R to S3L).

The columns are assigned to the re-
spective speed switching points P1 to
P4, and the switching delay P4 (max.
300 ms).

The following condition applies:
P1<0.9xP2<0.9xP3<0.9xP4
orP1=P2=0

EGS

Device type: UOC40 Programming mode

Switchrangs: 05 2560 pm Switch Name

Pl 2 P3 P4 st

On -———
{ }V { } Delay -
off - s3

Sicw
S1Cew
> SXw
S2Cew
S3Cw
S3Cew

P1 fpm] P2 fpm] P3 fpm]

P4 fpm] FroOu

P4-Delay :
ol Invett Erorswich o,

50 60 90 100
50 60 90 100
100 112
50 56
10 15 100
10 15 100

[V] underspeed

1
51—‘

V] direction dependent [¥] switch delay

Zoom
min

A
S2 ‘

U 0

1
53—‘

(2oom ]
|

-2560

Fig. 6-9:

-1280 0 1280 2560

Configuration EGS C module

The switching points are depicted in the graphic opposite.

A marker indicates the
current speed.
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The switches listed in the lines are allo- The values listed in the columns are allo-
cated as follows cated as follows

S1R SWitchi'ng speeds of switch_ 1 for P1 Hysteresis switching s_peed
clockwise direction of rotation for underspeed detection

g1 |Switching speeds of switch 1 for P2 Cut-in speed for underspeed
anticlockwise direction of rotation detection

g2R Switching speeds of switch 2 for P3 Hysteresis switching speed
clockwise direction of rotation for overspeed detection

g2 |Switching speeds of switch 2 for P4 Cut-off speed for overspeed
anticlockwise direction of rotation detection

g3R Switching speeds of switch 3 for P4 - Delay Delay time before cut-off of
clockwise direction of rotation the switching point P4 [ms]

g31 Switching speeds of switch 3 for
anticlockwise direction of rotation

Only those lines and columns are displayed that are relevant to the respective function se-
lected by checking the appropriate boxes.

An input value "0" in the fields P1 ... P4 deactivates the corresponding switch.
An input value "0" in the fields P1 ... P2 deactivates underspeed detection
(see Chapters: 6.3.1, 6.3.2).

CAUTION!
When switching delay is activated the actual cut-off speed can be higher than the
A set cut-off speed!

Observe also the information on determining switching accuracy described in the
Operating and Assembly Instructions "UOC 40 / ERC 40 _Manual"

The module is depicted in the display section as in Fig.: 6-10
Click "Write to device" to finish configuring the module.

6.3.1 Underspeed

Underspeed is detected. The respective switch closes first when speed P2 is exceeded;
the switch is opened again when the speed falls below the P1 threshold. The input col-
umns for "P1" and "P2" are depicted if underspeed detection is activated.

6.3.2 Rotation direction dependent

The switching speeds S1R ... S3R apply to clockwise direction of rotation. The speeds
S1L ... S3L apply to anticlockwise direction of rotation.

The input lines for S1IR-S3R as well as S1L-S3L are depicted if 'rotation direction depend-
ent switching' is activated.

If no ‘rotation direction dependent switching' is activated the switches S1 ... S3 are not la-
belled with a direction of rotation indicator R or L; the entered switching speeds apply in-
dependent of the direction of rotation.

O PLEASE NOTE!

l If ‘rotation direction dependent switching and underspeed are selected, the under-
speed function must be equal for both directions of rotation. Either active or inactive.
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6.3.3 Switching delay
The adjustable switching delay makes it possible to prevent the overspeed switch switch-
ing if the limit speed is exceeded only briefly. That can be appropriate during load shed-
ding, for example. If the speed P4 is exceeded the switches S1, S2 and S3 close, and
open only after the delay time set in the "Delay" field has elapsed. It is possible to set the
time between 0 and 300 ms. The cut-off function is not triggered if the speed again falls
below the P4 figure within the set delay time.

O

1l

PLEASE NOTE!

The delay time applies only to the cut-off function when the speed P4 is exceeded.
All other switching operations are triggered immediately.

6.4 Input accuracy of switching points
EGS C-Module (UOC 40 only):

Switching speed n

Input accuracy

n <100 rpm

XX.YY (e.g.: 15.87)

100 <=n <1000 rpm

XXX.Y (e.9.: 280.3)

n >= 1000 rpm

XXXX (e.g.: 2050)

ERC C-Module:

X: Integer places
Y: Decimal places

The input accuracy of the position switching points depends on the calibration factor.
The input of position switching points is limited to 9 decimal places. The number of
places after the decimal point is limited to 3 decimal places.

Calibration factor k Input accuracy position
switching points
k <10 | XXXXXXXX e.g.. 27354 .
X: Integer places
10 <=k <100 | XXXXXXX.Y | e.g.:27354.3 Y: Decimal places
100 < =k <1000 | XXXXXX.YY | e.g.: 27354.34
k >= 1000 | XXXXX.YYY e.g.: 27354.345
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6.5 Error handling

Numerous diagnostic measures check the functions )
and operating conditions of the UOC 40/ ERC 40 at  &dem: Undervotiage detected E—
power up and during runtime.

i

Fig. 6-10: Error message

In the event of a deviation, the error state is initiated and the error is stored in the
error memory.
An error distinction is made between "internal errors” and "external errors".

External errors are caused by external influences, e.g. exceeding the max.
permissible speed or exceeding the max. permissible temperature. The errors are
explained in the parameterization software with a brief description of the error, as
described in Chap.6.5.1 displayed.

Internal errors are e.qg. triggered by deviations of the device-internal program
sequence. The errors are displayed in the parameterization software with error
number and the designation "internal error”. An analysis of the cause of the error is
only possible with expert knowledge. To do this, the user must send the contents of
the fault memory to the manufacturer (see chapter 4.1.18).

Faults are reset by a reset (reset input or reset button in the US42Pro software) or by
interrupting the supply voltage (> 2s).

Regardless of the category, the error condition is initiated when an error occurs.
Resetting the error triggers a system restart with a complete system check. If an error
is detected again, the UOC 40/ ERC 40 remains in fault state.

The error state can be assigned to a switching output with the parameterization
software.
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6.5.1 Error table
Error no.

30

31, 32
35

36

40

45

48

50

51

52

55

60

61

62

63

65

66

67

68
100-255

Description

Undervoltage detected

Overvoltage detected

Fell below min. temperature

Max. temperature exceeded

Error reset input

Error preset input

Error Error output

Fall below system limit

System limit exceeded

Operating range (system limit) too great
Maximum device speed exceeded
Start-up during parameterization
Start-up during switch test

Start-up during preset (software only)
Invalid condition for preset

Timeout during parameterization
Switched off during parameterization
Switched off while saving parameters
Start-up during factory reset

Internal diagnostics error detected
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